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Where to Find Help When You Need It 

Student Computer Help Web Site 
The computer help web site for students provides information about the type of help you 
can get and locations where help is available. To find this information, look to: 
http://rohan.sdsu.edu/~students
 

Help from the BATS Web Page  
BATS (Baseline Access, Training and Support) is a California State University initiative 
to provide all students, faculty, and staff with "baseline" access to information resources 
via networks, training in the uses of baseline hardware and software systems, and 
ongoing professional and technical support for utilization of computer resources at San 
Diego State University.  You can access the BATS Web Page by pointing your browser 
to: http://rohan.sdsu.edu/~bats/
 

Help in the Love Library Student Computing Lab 
The Student Computing Lab's purpose is to facilitate students in completing assigned 
class work, as well as provide assistance to students having computer problems relating 
to the Internet, Dreamweaver 
, SPSS, File Transfers, PC Operating Systems, Microsoft Office Software and Business 
Databases. 
Location:   2nd floor of the Love Library building in LL-220 
Hours:   Monday - Thursday    7:00am – midnight 

Friday     7:00am –  6:00pm  
Saturday    10:00 am –  6:00pm  
Sunday      10:00am – midnight 
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Your Place in the Internet World 
 
Is it a Web Page or a Web Site 
The difference between a web page and a web site is that a site is a series of web 
pages that are linked together. All of the pages should be located in the same folder on 
a server, but the information presented on a page may be generated by a database 
located somewhere else. Some examples of web sites that are backed with large 
databases are: 

• www.yahoo.com 
• www.amazon.com 
• www.autotrader.com 

 
Your Basic Web Site 
In these classes you will be creating a basic web site about yourself; the site will include 
a homepage (index.htm), an on-line resume (resume.htm), a background page 
(background.htm), a page of your interests (interests.htm), a page of links to other 
websites (links.htm), and a page of your favorite photos (photos.htm). Since this will be 
your web site you are free to add or subtract from the site using the skills that you will 
learn in class. If you were to look at the public_html folder of a sample web site, it would 
look something like figure 1. 

 
Figure 1 public_html folder contents 
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Web Design Principles 
 
Alignment 
People surf the Web mostly for information. One of the most successful sites on the 
Web is Yahoo. It loads fast, and has lots of quality information. Alignment of text and 
other visual elements facilitates "scanning" for information, as well as reading. It is 
easier to scan a page that uses alignment well. 
 
Proximity 
Web users' eyes are typically moving quickly. By putting blocks of information together, 
with bigger spaces between blocks that are conceptually distant, and smaller spaces 
between blocks that "belong" together, you can effectively create conceptual 
relationships among page elements even before the user starts reading. Just by looking 
at the blocks of content and graphics the user will get a feel for the scope of information 
on a page. 
 
Repetition 
Repetition means consistency. For text design, it means using the same headers on 
each page in the same place, with the same size and type of font, and so forth. On a 
Web site, repetition also applies to the navigation elements (buttons and links). If the 
user enters a Web site and sees navigation buttons on the top of the page, and then on 
the next page they are on the left side, they are needlessly confused, not to mention 
slightly annoyed. Navigation buttons should be in the same place on each page of a 
site, with the possible exception of the splash or main page.  
 
Repetition is used on Web pages to establish a "look and feel" which holds the site 
together. Good Web sites give you an immediate sense on each page that you are still 
"in" that Web site. This is done using colors, icons, navigation bars, backgrounds, and 
do so forth. 
 
Contrast 
Contrast has long been used in print to lead readers' eyes around a page. While most 
people's eyes start in the upper left of a Web page and move right it happens only in the 
first few seconds. After that, we guide the user's eye movements by using contrast. 
Beyond the use of Bold in text, bullet points, or blocks of colors, multimedia such as 
animation can be used to pull a viewer's eyes to where you want them. Like most 
animals, our eyes are instinctively drawn to anything that moves.  
 

2 



 

Follow these Rules 
Rules are made to be broken? Yes, but in order to break them, you have to establish 
them in the first place, and then break them, well, according to the rules! 
 
What does that mean? 
 
Take a look at some print material such as magazines or coffee table books, and some 
Web sites. Notice how even the most outrageous and "post-modern" designs end up 
using the four principles outlined above. For instance, when designers break rules about 
contrast, they do it consistently, that is, they repeat it, in order to establish the broken 
rule as a new rule -- at least within their design. 
 
A really useful exercise is to find a print or Web page you think is terrific, and analyze it 
using the four principles described above. You'll begin to really understand the specific 
elements and arrangements of those elements that are making the page so attractive to 
you. Then, you're in a position to adapt those elements and arrangements in your own 
designs. Particular type styles, line spacing, color palettes, and so forth, are always very 
intentional in a good design. 
 
How to get started 
In this class everyone will be building the same site, with some variations of background 
color and choice of buttons. Everyone will use the same layout and placement, but if 
you were going to start from scratch, there are a couple ways to plan out your site. Both 
methods can be accomplished with a pencil and a piece of paper, or you can use other 
 

index.htm
My Company 
Home Page 

department.htm 
Company 

Department 
Directory 

links.htm 
Links to 

other sites 

products.htm
Company 
Products 

people.htm
Company 
Personnel 

Home Pages 

Figure 2 Site Map 

sales.htm 
Sales Dept 

mkt.htm 
Marketing 

ship.htm 
Shipping 

prod1.htm
1 st  product

prod2.htm
2 nd  product

prod3.htm
3 rd  product

jones.htm
Sam

smith.htm
Bill

bush.htm
George
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computer programs that you are familiar with. The first method is called a site map, the 
example is for fictional company with more than one level. The map shows relationships 
between different pages, notice that the file name for each page is shown at the top of 
each box.  
 
The point of a site map is to plan out your site before you start building. Now this may 
not seem like an important step in the process, but it is vital to do as much up front work 
as you can before you start working. 
  
This is a top down hierarchy site map. It is widely used to represent your average 
hierarchy Web site, in other words, a typical site with several top level links that are on 
every page, and then more pages that are reachable only from certain pages.  
 
There are certain *assumptions* in this format. Assumptions are dangerous. Let's make 
sure we're assuming together. 
 
1. The "Home" page has all of the links to the second layer. In other words, the first 

page the user comes to will have links to "Departments", "Products", "Personnel", 
and "Links".  

2. These four links will be on every page in the Web site. That means you can get to 
these four links from anywhere on the site, but we do NOT need to put the arrows 
explaining that. If we did, we'd have so many arrows we'd run out of room for the 
squares!  

 
3. Each box is a single HTML page; that's why they are named. Naming the file in the 

site map means anyone can build this site and they will know which file is which.  
 
4. Any page below the second level is not reachable "across" the map. In other words, 

from "Sales" you can't go directly to "Product 2".  
 
As you go out in the world and propagate more site maps, you can come up with your 
own modifications of this format to fit your project. Just make sure that all parties 
involved in the project assume the same things.  
 
When developing navigation for web sites and other multimedia, it is important to 
consider what users need or want to know, their preferences concerning navigation, as 
well as the different navigation methods available to you. 
 
The second method for planning your site is a storyboard, a rough sketch of how you 
want you pages in the site to look, again you can use a pencil and paper or a computer 
program as shown in figure 4 below.  
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MMYY  CCOOMMPPAANNYY
Departments

Products

Personnel

Links

Yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada
yada yada yada yada yada yada yada yada yada yada

 

The site map and storyboard can be used together, if you look at creating your web site 
like making a film, then the site map would be your script and the storyboards a drawing 
of each scene. 

Figure 3 Sample Storyboard 

 
Using Images on the Web 
 
Before we dive in, here are three central concepts that are essential to understanding 
images and the Web.  
1. GIFs can have only 256 colors. They should be used whenever possible and are 

good for icons, text, and original digital art with limited colors. And, by the way, "GIF" 
is pronounce with a hard "G" as in Good, not a soft "G" as in George. 
 

2. JPEGs can have millions of colors and are best for pictures of people, nature and 
anything with a lot of complex colors. 
 

3. Everything on the Web is protected by copyright, including images! Ask before you 
use.  

 
The Web handles text very well, it downloads quickly, and there are few technical 
issues. But people increasingly come to the Web for more than text-based information, 
which the Web doesn't handle nearly as well. 
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When you start to add visuals to the text on your Web site, you start walking a thin line 
between pages that download quickly and pages that provide information using visuals, 
but download more slowly. If you consider that a good Web site should perform quickly 
for impatient viewers and provide valuable information, then how do you balance these 
conflicting priorities? 
 
One way is to make sure that if a user has to wait for an image or other media, they 
know exactly what they are waiting for and have made a deliberate choice to do so. 
Another way is that it is worth the wait -- it contributes substantively to the information 
(or entertainment) the user is seeking.  
 
What are some other ways? 
 
Find a Web site with a variety of images. Can you predict which ones are GIFs and 
which ones are JPEGs? Test yourself. Download some of them to the desktop and 
check your predictions. Were there any exceptions to the rules? Are photos sometimes 
GIFs? Are simple graphics sometimes JPEGs? 
 
Things to look for when you are done 
 
Basics: 
 

1. Clearly displayed information about a single topic using several web pages and 
multimedia where applicable  

2. A consistent navigation interface  
3. Less then 10MB in total space  
4. San Diego State disclaimer as a footer on every page in the site. 
5. The disclaimer should read: "This is a personal home page and does not 

represent the opinions of San Diego State University"  
 
Questions you ask yourselves: 
 
Layout 
 

1. Are the principles of good layout design adhered to?  
• Contrast  
• Repetition  
• Alignment  
• Proximity  

2. Information  
• Did you convey information about a single topic?  
• Does the information target the intended audience?  
• Did you have reference areas for further study of the topic?  
• Did you show evidence of researching your topic?  

 
 

6 



 

3. Navigation  
• Do I know where I am within the site at all times?  
• Do I know how I got there?  
• Are there any broken links?  
• How long do I have to wait for the page to load?  
• Is it worth the wait?  

4. Interface Design  
• Do I know what to click?  
• Do I know where a link will take me before I click on it?  
• Are there obstacles preventing me from clicking something?  
• Can I easily get the information I am seeking?  

5. Screen Design & Layout  
• Is each element on the page in a place that is easy to access?  
• Does the layout get radically destroyed if I change the size of the browser 

window?  
• What happens to the layout if I change the default font, size, etc.?  
• How much scrolling do I have to do?  
• Does implementation of media (text, pictures, video, etc.) serve a useful 

purpose?  
6. Text  

• Is everything spelled correctly?  
• Is everything grammatically correct?  
• Is the text a reasonable size for reading?  
• Are large blocks on solid bright backgrounds? And are they easy to read?  

7. Site Management  
• Are all folders and files named properly? Folders: lower case, no spaces?  

Files: lower case, no spaces, file extension?  
• Are all folders and files organized on the web server in a logical and clean 

way?  
• Are there any extra files, not used in the project floating around?  
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Web Page Accessibility 
If you are creating or working on any official web pages, it is required that each of these 
pages is accessible to all persons using the Internet. What does it mean to be web 
accessible? — Web accessibility means making sure that everyone, regardless of 
disabilities, can effectively use the web sites they visit. According to the Web AIM 
Organization (http://www.webaim.org/), an estimated 20% of the U.S. population has 
some kind of disability that can limit their use of the Internet. 
 
For more information please refer to the SDSU Web Site on Accessibility. 
http://access.sdsu.edu/ 
 
The BATS program conducts workshops on Web Accessibility, please check the BATS 
Web Site or the Faculty Staff Schedule for dates and times of the workshops. The 
handout for this workshop is available at: 
http://www-rohan.sdsu.edu/%7Ebats/PDF/FacStaff/WWW/Accessibility_FS.pdf 

What we will be doing 
 
We will be creating a basic website for you, using two programs: in the first class we will 
be using Microsoft FrontPage, in the second class; we will be creating the same website 
in Adobe Dreamweaver. FrontPage is a very capable program that most people starting 
out in web design feel comfortable using because the interface looks very much like 
Microsoft Word.  Most advanced users utilize Adobe Dreamweaver for their websites, 
we will be creating the same website that we created in FrontPage so that you can see 
the differences in the two programs, then in subsequent classes we will expand upon 
what you will learn here and create more elaborate and functional websites. 
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Macromedia DreamWeaver 
Before we start in DreamWeaver: 
On the desktop, click on the Local Temp Icon. 
Create a new folder with your name on it. 
 
On the desktop, click on the BATS Temp Shortcut, inside BATS Temp, open the folder 
named Charles, inside Charles folder, open the Web Design folder, inside the Web 
Design folder, open Creating a Web Site – DreamWeaver. Copy the public_html to your 
named folder. 
 
We are going to play around a little bit in Adobe Photoshop and create a background for 
you web site, you are going to name this file back.gif. You are also going to create a 
header for the top of your website with your name on it. Name this file name.jpg.  
Save both of these files in the images folder inside your public_html folder. 
 
We are then going to go to the internet and download some images to use on your site, 
make sure to save these in the images folder inside your public_html folder. 
 
Here are the steps you are going to follow in class to create your website. 
 
Open DreamWeaver. The top menu should look like this: 

 

1. DW has its own FTP program built in, so the first step is to set up your site.  
Go to the Site menu and click on Manage Sites, a dialog box will appear: 

Click on the New… button 
and select site from the menu 
Call the new site whatever 
you like.  

 For example:  
Your Name’s Site 
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2. Once you have named your site, the Site Definition box will open, for this class 
we will use the Basic Tab at the top of the window. Here are some answers to 
the questions that are asked: 

a. Do you want to use server technology – No 
b. How do you want to work on local files during development – Edit local 

copies on my machine 
c. How do you connect to the local server – FTP 

Host name – rohan.sdsu.edu 
Folder name – public_html 
FTP login – bisc#### 
Password – exactly as appears on the slip of paper you got in class 

d. Click the Test Connection button 
e. Do you want to enable checking in and out of files – No 
f. Check the Summary of your inputs and click on Done. 

3. Your site should now be in the Files Inspector at the bottom right of the DW 
window. 

4. Go to the Modify Menu and select Page Properties 
a. Select a Font to be your default font 
b. Click on the browse button next to Background Image. Select the back.gif 

file from your images folder inside your public_html folder. 
5. Go to the Insert menu and Select Table – the Table menu will appear: 

 
 
Set the parameters just as they are in the figure to the right. 
7 rows, 2 columns, border 0. 
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6. Scroll over the dotted line between the two columns, click and drag the line to the 
left until the left column is 65 pixels wide, and the right column is 685 pixels wide. 

7. Select all seven cell in the left column, right click and select Table > Merge Cells. 
8. Click in the top row of the right column, go to the Insert menu, select Image. 

Insert the name.jpg file you created in Photoshop. 
9. Go to the second cell down, insert the image from the Internet you downloaded. 

10. In the third cell, insert one of the animated email icons from your images folder. 
Then type an email address, for example jstudent@rohan.sdsu.edu 
Select the email address, at the bottom of the window is the Properties Inspector 

 
in the Link window type -  mailto: and then the email address, 
for example – mailto: jstudent@rohan.sdsu.edu 

11. In the fourth row of the right column, go to the Insert menu, select Table. 
a. You are going to create a nested table, which is a table that is inside of a 

larger table. This table will have 1 row and 6 columns, set the width to 
100%, set cell spacing to 3 pixels, and the border size to 0. 

b. In the six cell you be inserting small images that look like buttons, as you 
put images the cells will change size, do not worry, as you put all of them 
in they will all be the same size when you are done. 
Insert the home.jpg image in the first cell 
Insert the background.jpg image in the second cell 
Insert the interests.jpg image in the third cell 
Insert the links.jpg image in the fourth cell 
Insert the photos.jpg image in the fifth cell 
Insert the resume.jpg image in the sixth cell 

c. You are now going to link those images to pages in your web site by 
typing the page name in the Link window of the Properties Inspector when 
you have the button highlighted. 
Link the Home button to index.htm 
Link the Background button to background.htm 
Link the Interests button to interests.htm 
Link the Links button to links.htm 
Link the Photos button to photos.htm 

d. For the Resume button, use the point to file tool  next to the Link window 

 to link the Resume button to resume.htm 
e. You are now going to create roll over buttons by using the swap image 

command. An image swap is exactly as it is named, when you scroll over 
an image, a different image is displayed, in this case making the button 
light up. 
Open the Tag Inspector on the right side of the window. 
Select the Behaviors Tab. 
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Select the Home Button, and then click on the + menu on the Tag 
Inspector and select Swap Image. 
The Swap Image box will appear, click on browse and select the 
highlighted version of the home button called home_lit.jpg. 
Assign the highlighted version of each of the other buttons as follows: 
background_lit.jpg to the Background button 
interests_lit.jpg to the Interests button 
links_lit.jpg to the Links button 
photos_lit.pjg to the Photos button 
resume_lit.jpg to the Resume button 

12. Leave the fifth row of the right column empty for now. 
13. In the sixth row of the right column, change the justification to center on the 

Properties Inspector. Insert the sdsu_button.jpg file from your images folder. 
14. Click on the SDSU button, link it to http://www.sdsu.edu, after you link it to 

SDSU’s web site, change the target to blank in the Target window under the Link 
window on the Properties Inspector. 

15. In the seventh row of the right column, change the justification to the center and 
type these words -  This is a personal home page and does not represent the 
opinions of San Diego State University – this is a disclaimer and must be on 
all pages of your web site. 

16. It is now time to save your work. Go to File and click on Save. Save this file as 
index.htm 

17. You have now saved your Home Page. 
18. Now open your public_html folder, select the index.htm file and copy it, then 

paste the file into your public_html folder four times.  
You will have a file list like this: 
index.htm 
Copy of index.htm 
Copy(2) of index.htm 
Copy(3) of index.htm 
Copy(4) of index.htm 

19. Change the file name as follows: 
Copy of index.htm to background.htm 
Copy(2) of index.htm to interests.htm 
Copy(3) of index.htm to links.htm 
Copy(4) of index.htm to photos.htm 

20. Don’t worry about the Resume page, you have a preformatted page for your 
resume in your public_html folder. 

21. You can now go and add content to each of your pages, starting with your home 
page. 

22. Once you have added content to all of your pages, it is time to upload to the 
server. 
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23. On the Files Inspector: 

 
 
Select all the files in your site by holding the shift key and clicking on the first and 

last file, click on the Blue Up arrow  to upload your files. 
 

24. Go to internet and check out your website. http://rohan.sdsu.edu/~bisc#### 
 

13 


	 
	Table of Contents 
	 Where to Find Help When You Need It 
	Student Computer Help Web Site 
	Help from the BATS Web Page  
	Help in the Love Library Student Computing Lab 
	Your Place in the Internet World 
	Is it a Web Page or a Web Site 
	Your Basic Web Site 
	Web Design Principles 
	Alignment 
	Proximity 
	Repetition 
	Contrast 
	 Follow these Rules 
	How to get started 
	Using Images on the Web 
	Things to look for when you are done 

	 Web Page Accessibility 
	What we will be doing 
	Macromedia DreamWeaver 


